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SlideMinder® System
Chapter 1.  Introduction

Ground movement in and around open pit mines, large construction sites, or
highways can damage or destroy expensive equipment and cause injury or
death to workers and bystanders. The SlideMinder system addresses this
problem by providing real-time monitoring of ground movement. When a
dangerous rate of ground movement is detected, the SlideMinder system
issues a hazard warning to all affected personnel.

Figure 1-1.  System Overview
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The SlideMinder system consists of a number of hardware and software
components. Hardware components include one or more extensometers, a base
station radio, and base station computers. The remote extensometer and other
hardware components are covered in the 1Hardware Installation Manual.
Software components, described in this manual, include the ExtensBase
communication program and the ExtensMon program. ExtensMon is used for
storing movement data in a central database and for viewing the movement data.

Throughout this manual, the term ExtensMon server is used to refer to the
segment of the ExtensMon program that maintains the central database
and communicates with the ExtensBase program. There is only one server
per SlideMinder system. The term ExtensMon client is used to refer to
segments of the ExtensMon program running on computers other than that
running the ExtensMon server. ExtensMon clients are used for viewing
the data stored in the central database by the ExtensMon server and for
receiving warning messages.

The extensometer is a solar-powered remote sensing device that detects
ground movement and uses a radio link to report ground movement to the
base station. All of the extensometers installed around the worksite
communicate with the ExtensBase and ExtensMon server components
through the base station radio. If communication with the base station is
interrupted, the extensometer can store movement data until the link is restored.

The base station radio is connected by a serial cable to the computer where
the ExtensBase program is located. The ExtensBase program uses the base
station radio to collect ground movement data from the extensometers and
send commands to set extensometer parameters such as the data reporting
interval. The ExtensBase program sends the ground movement data it collects
to the ExtensMon server.

If communication with the ExtensMon server is interrupted, ExtensBase will
store the movement data until communication with the central database is
restored. The amount of movement data, or the corresponding length of time
that the data can be stored in this manner, is a function of the size of the hard
drive on the computer where ExtensBase is installed. If the storage capacity
is exceeded, some data may be lost.

___________________
1  Crouse, Ronald L., P.E., and Lowe, D. J., 2003, Radio Telemetry Wireline Extensometer

System, Hardware Installation Manual, Tucson, Arizona: Call & Nicholas, Inc.
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The ExtensMon server stores the ground movement data, received from the
extensometers by ExtensBase, in a database. The ExtensMon server also
presents the data in an intuitive graphical format and issues warnings when
ground movement exceeds preset limits. ExtensBase and the ExtensMon
server can coexist on the same computer, or they may be located on separate
computers on the same LAN network.

The ExtensMon server compares the ground movement rate to warning
criteria based on a preset warning notification protocol. Numerous warning
protocol settings are possible, allowing different procedures to be
implemented based on different incremental movement rates. When ground
movement exceeds a preset threshold, the ExtensMon server sends warning
messages via pager, modem, or LAN to the equipment control office,
designated engineer, and other affected personnel.

ExtensBase can activate warning devices, such as strobe lights and sirens, at
the affected extensometers. All personnel should be trained to stop work
immediately and leave the area being monitored when the warning devices
are activated. The equipment control office can also notify equipment
operators of the hazard by radio, as a backup procedure.

After receiving the warning message, the designated engineer can use an
ExtensMon client to access the central database and review ground movement
data while connected to the network or at home over the Internet. The
designated engineer may then elect to call the equipment control office to
review the situation and set interim operational procedures to be followed
pending a more permanent solution.
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SlideMinder® System
Chapter 2.  Installation

2-1. SOFTWARE PACKAGE CONTENTS

The SlideMinder® base station software package contains the following items:

• SlideMinder Software Installation CD
• SlideMinder Software User’s Guide (this book)

Please contact the technical support team if any of these items are missing or
damaged. Consult the SlideMinder Hardware Installation Manual for base
station hardware package contents and hardware installation instructions.

Call & Nicholas Instruments, Inc.
2475 N. Coyote Drive, Tucson, AZ 85745
Tel. (520) 670-9774    Fax (520) 670-9251
cni2@cnitucson.com

2-2. REQUIREMENTS

Before proceeding with installation of SlideMinder software, take a moment
to ensure that the target system meets the following minimum requirements.
If ExtensBase and ExtensMon are to be installed on the same computer, use
the requirements listed for ‘ExtensBase with ExtensMon’.

Processor: Pentium

Processor Speed: 500 MHz

Physical Memory: 256 MB RAM

Operating System: Microsoft® Windows 2000 or XP

Free Disk Space:
ExtensBase/ExtensMon only: 500 MB
ExtensBase with ExtensMon: 1 GB

Serial Ports:
ExtensBase with GPS: two 9-pin RS-232 ports

ExtensBase w/o GPS: one 9-pin RS-232 port
External Modem: Additional 9-pin RS-232 port
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Networking:
ExtensBase/ExtensMon only: TCP/IP-capable network connections

must exist between ExtensBase, the
ExtensMon server, and the ExtensMon
central database. The network may take
the form of a Local Area Network (LAN).

ExtensBase with ExtensMon: No network hardware is required if
ExtensBase and ExtensMon will both
be installed on the same computer.
However, the TCP/IP protocol stack
(part of the Windows operating system)
must be installed for the two programs
to communicate with each other.

Also, warnings cannot be issued nor
can the database be accessed from an
external computer without a network.

ExtensBase without GPS: To properly operate the SlideMinder
system, the computer running the
ExtensBase program must maintain
accurate system time. ExtensBase
installations lacking the optional GPS
receiver must be connected to the
Internet or to a LAN where accurate
system time can be obtained.

2-3. INSTALLING THE SOFTWARE

To install ExtensBase or ExtensMon, insert the SlideMinder software
installation CD into the CD-ROM drive of the target system. If the installation
process does not start automatically, double click on “My Computer” then
navigate to the CD-ROM drive and double click on the “Install.exe” file.
Alternately, click on the Start menu, select Run and enter “d:\install” at the
prompt, where “d” is the letter of the CD-ROM drive.

ExtensBase must be installed before ExtensMon.
If ExtensMon is already installed, exit the program before
installing ExtensBase.

For best results, complete all hardware installation before
installing the SlideMinder software.
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Once the installation program starts, choose the software package to install
(ExtensBase or ExtensMon) and follow the instructions that appear on the
screen. If Setup finds files on your computer that are more current than those
on the CD, it will ask to keep or replace the existing file. Always click “Yes”
to keep the existing file. If a “UDPPort License” window appears at any
time during installation or operation, click “OK” to dismiss the window.
(The license agreement is not a necessary part of this installation.)

When the installation of the first software package is complete, the other
software package may be installed. Be sure to check the root directory of the
installation CD for the “Readme.txt” file. The readme file may contain
information on known installation issues or last-minute software modifications
and should be reviewed before starting either ExtensBase or ExtensMon.

2-4. SOFTWARE CONFIGURATION

A few additional configuration steps must be taken before the SlideMinder
software components can be put into operation:

• The ExtensBase program must be configured with the correct COM
port settings if the base station radio was not installed on the default
radio port (COM 1) or the optional GPS receiver was not installed
on the default GPS port (COM 2).  See Chapter 3, Section 3-2.2 of
this user's guide for instructions regarding COM port settings.

• The IP addresses or the machine names (DHCP protocol) of the
computers running ExtensBase and the ExtensMon server must be
known before SlideMinder software installation can be completed.
Contact the technical support team if IP addresses or DHCP status
are unknown.  Refer to Chapter 3, Section 3-2.3 for details on how
to set the ExtensBase IP address and Chapter 4, Section 4-2.1.1 for
ExtensMon IP address instructions.

• When the ExtensMon server is installed, a central database file must
be created for storage of ground movement data.  See Chapter 4,
Section 4-3.1 for further details.  If an ExtensMon client is being
installed, the program must be given the location of the central
database file.  See Chapter 4, Section 4-2.1.1 for details regarding
ExtensMon client configuration.
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SlideMinder® System
Chapter 3.  ExtensBase

3-1. RUNNING EXTENSBASE

Double-click on the ExtensBase icon or select ExtensBase from the Windows
“Start” menu to start the program. A splash screen will be briefly displayed,
followed by the main ExtensBase window.

3-1.1 Splash Screen
The splash screen is displayed on system startup while ExtensBase initializes
the base station radio and establishes communication with ExtensMon. This
process may take several seconds.

If any error messages appear during startup, please consult Chapter 5 of this
manual for troubleshooting procedures.

Figure 3-1.  ExtensBase Splash Screen
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3-1.2 Main Window
Once initialization is complete, the ExtensBase main window is displayed.
The ExtensBase main window contains a box with current status information
for each RSU in its database. Figure 3-2, below, depicts a system with two
RSUs. As more RSUs are added, the ExtensBase main window will grow
larger to accommodate the new units. Each RSU box on the main window
includes two buttons: “Read” to query the RSU, and “Properties” to open
the “RSU Properties” window.

The function of each data field is as follows:
Updated – Time and date a report was last received
Displacement – Total ground movement since installation
Battery – Current battery voltage
Temperature – Current temperature at the unit

The text box displays communication status, that is, it shows the length of
time before an RSU is expected to “wake up.” (See Section 3-4.1.4 for more
information about the RSU sleep mode).

The WD field appears next to the
“Temperature” box if the RSU is equipped with
a warning device, such as a siren or flashing
light.  If the warning device is activated, the
WD box will change to red.

Figure 3-2.  ExtensBase Main Window

Figure 3-3.
Warning Device Indicator
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Important status messages about the RSU,
such as “Encoder Error” or “Hi-Res Mode,”
are displayed at the top of each RSU box.
These messages will appear in large red
letters. Please consult Chapter 5
(Troubleshooting) or contact the technical
support team for more information regarding
these RSU status messages.

3-2. SYSTEM SETTINGS

The ExtensBase program system settings must be configured when the
program is first installed. Once initialization is complete, and the ExtensBase
main window is open, click on the “Properties” button in the lower right-
hand corner to open the “RSU Properties” window.  ExtensBase program
properties and RSU parameters are configured from this window.

Click on the “System Properties” button in the upper right-hand corner of
the “RSU Properties” window to display the system settings.

Figure 3-5.  RSU Properties Main Screen

Figure 3-4.
RSU Status Message
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3-2.1 Properties
There is only one parameter listed in the “System Properties” box. Select
either “Imperial” or “Metric” to set the ExtensBase display mode.  If “Imperial”
is selected, then units such as inches, feet, and degrees Fahrenheit will be
used for all ExtensBase displays. The units of centimeters, meters, and degrees
Centigrade will be used if “Metric” is selected.

3-2.2 Serial Ports
If the base station radio was not installed on the default radio port (COM 1),
or the optional GPS receiver was not installed on the default GPS port (COM 2),
then the ExtensBase program must be configured with the correct COM port
numbers. Enter the COM port used for the base station radio in the “Base
Radio” box. Enter the COM port used for the GPS receiver in the “GPS”
box; enter zero (0) if there is no GPS receiver.

3-2.3 Communications
The ExtensBase program must be told the location of the ExtensMon server
before communication between the two will take place. Enter the IP address
or machine name of the computer where the ExtensMon server is located in
the “IP Address” box. If both programs are located on the same machine,
then the IP address of “127.0.0.1” can be used.  Ensure the “TX Port” is set

To change a setting, click on the desired option or text box and enter the new
value (if required). Click the “Save Properties” button to save changes to
these settings. If a mistake
is made, the last settings to
be saved can be restored by
clicking on the “Revert to
Previous” button. To go
back to the “RSU
Properties” display, click
the “OK” button in the
lower right-hand corner of
the window.

When changes are made to any of the
ExtensBase system settings, the program must
be restarted before the changes will take effect.

Figure 3-6.  RSU System Properties Screen
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to 1194 and the “RX Port” is set to 1195.  Do not change these port numbers
unless there is a conflict with another software program.

If the IP address of the ExtensMon server is unknown, go to the ExtensMon
server and click on the Windows “Start” menu. Select the “Run…” option
and type in “cmd” at the prompt. Click “OK” and the “cmd.exe” window
will open. Type in “ipconfig” at the prompt and press the “Enter” key. The IP
address of the computer will be displayed on a line beginning with the label
“IP Address.” This is the number that should be entered in the “IP Address”
box on the ExtensBase “System Properties” display.

The IP addresses of both ExtensBase and ExtensMon can be static or use
DHCP protocol.  When  using DHCP, enter the machine name in the IP address
field, rather than the IP numbers.

3-3. OPERATIONS

The configuration of program settings discussed in the previous section is
only performed on rare occasions, such as during installation and at the
direction of the technical support team. The operations described in this
chapter will be used most frequently in support of routine ExtensBase
communication functions. Operations covered in this section include adding
and removing RSUs, changing RSU settings, sending settings to an RSU,
and viewing diagnostic displays.

Figure 3-7.  The “ipconfig” command



3-6           NOTES

3-3.1 Add/Modify Extensometer (RSU)
To add a new extensometer (RSU), first bring up the “RSU Properties”
window by clicking on the “Properties” button of the main ExtensBase
window.  When the program is first run, a default RSU with the name
“RSU100” will be shown.  This name, as well as the radio ID, can be modified
using the “Edit RSU” function.  There must be at least one RSU at all times.

3-3.1.1 Create or Select RSU
To create a new RSU, click on the “New RSU”
button in the upper left-hand corner of the
window.  The parameter boxes will be filled with
default values and opened for editing.

To modify the parameters of an existing RSU,
use the VCR buttons located in
the top center of the “RSU
Properties” window or the
“Name” drop-down menu to
select the desired RSU.

When the name of the desired RSU appears in
the “Name” box, click on the “Edit RSU” button,
located immediately to the right of the “New
RSU” button in the upper left-hand corner of the
“RSU Properties” window. Clicking the “Edit
RSU” button will open the parameter boxes for
editing.  All fields will turn blue when the “Edit
RSU” button is selected.

3-3.1.2 RSU Identification
To add a new RSU, enter a unique alphanumeric designation for the new
RSU in the “Name” box. Enter the radio ID for the new RSU in the “Radio
ID” box. The radio ID must be unique and must match the ID number
supplied with the RSU. The ExtensBase program will be unable to
communicate with a new RSU if this box is left blank or filled incorrectly.
Please check the RSU documentation or contact the technical support team
if the radio ID is unknown.

Editing mode may be exited at any time by clicking
on the “Edit RSU” button.  No changes will be applied.

Figure 3-8.
Create New RSU

Figure 3-9.  Select Existing RSU

Figure 3-10.  Edit RSU
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3-3.1.3 Set Properties
RSU properties include: •  limit thresholds

•  sleep mode control
•  equipment options
•  extensometer sampling interval
•  extensometer displacement limit

These settings have a direct correlation with RSU operation and system
performance, so they should be modified only in consultation with the technical
support team. Consult Section 3-4 “RSU Properties,” for further details.

3-3.1.4 Save Properties
Once an RSU has been identified and its
properties set, the new data must be saved
before it takes effect. Click on the “Save RSU”
button to save the new RSU or to save changes
to an existing RSU. The “Save RSU” button is
located immediately to the right of the “Edit
RSU” button in the upper left-hand corner of
the “RSU Properties” window.

When the confirmation window
appears, click “OK” to save the
selected RSU properties, or
“Cancel” to abort the operation.

If a mistake is made, click on the
“Cancel Changes to RSU” button

to reverse all changes made to the selected RSU since the last time “Save
RSU” was clicked. Clicking the “Edit RSU” button will cancel all changes
and exit the editing mode.

3-3.1.5 Send Properties
Clicking the “Save RSU” button will automatically
transmit the changes to the RSU.  Alternatively, click
the “Send Properties” button in the lower left-hand
corner of the “RSU Properties” window to send
operational parameters to the selected RSU.

Figure 3-11.  Save RSU

Figure 3-12.  Cancel Changes

Figure 3-13.
Send Properties
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When the confirmation window opens, click “OK” to send properties to the
selected RSU, or “Cancel” to abort the operation. The ExtensBase program will
usually respond with a message stating  that the selected RSU is currently in
“Sleep Mode.” (See Section 3-4.1.4 for details regarding RSU “Sleep Mode.”)

The ExtensBase program cannot send the messages to set the RSU properties
until the RSU awakens from “Sleep Mode” and activates its radio. ExtensBase
therefore stores the messages so they can be sent the next time the selected
RSU wakes up. Click the “OK” button to dismiss this message.

Fields that have been modified will appear with a yellow background and
their current values until the new changes have been sent to the RSU.  Click
the “Show Pending” button to see the changes to be sent.  Click the “Show
Current” button to see the current settings.

3-3.2 Remove an RSU
To remove an RSU, first select the RSU to be
removed. When the name of the desired RSU is
displayed in the “Name” box, click on the
“Delete RSU” button located immediately to the
right of the “Save RSU” button in the upper left-
hand corner of the “RSU Properties” window.

When the confirmation window appears, click “OK” to delete the selected
RSU, or “Cancel” to abort the operation.  There must always be at least one
RSU in the list.

3-3.3 Set Distance
When an RSU is inadvertently reset (the displacement suddenly reads zero)
the extensometer can be reprogrammed with the correct displacement.  Select
the desired RSU, then enter the desired displacement in the box immediately
to the right of the “Set Distance” button near the center of the lower edge of
the “RSU Properties” window.  If the ExtensBase program is set to use

Figure 3-14.  RSU Sleeping

Figure 3-15.  Delete RSU
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imperial units, then the displacement is measured in inches.  If metric units
are in use, then the displacement must be expressed in centimeters.

Click “Set Distance” to send the new displacement to the selected RSU.
When the confirmation window appears, click “OK” to set the displacement
for the selected RSU, or “Cancel” to abort the operation.  The last recorded
displacement value can be obtained through ExtensMon, using the Tables
option under the View menu.

3-4. RSU PROPERTIES

All of the subsections in this section refer to the following illustration.

The RSU (Extensometer) properties are covered in detail in this section. For
information regarding ExtensBase program settings such as COM ports, IP
address, and units of measurement, see Section 3-2.   When a new RSU is
created, default values for each parameter are shown.

Figure 3-16.  Displacement Distance

Enter Displacement Value

Figure 3-20.  RSU Properties Window
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3-4.1 General RSU Properties
The “General” box of the “RSU Properties” window contains a number of
RSU parameters. The RSU name and radio ID, limit thresholds, sleep control,
hardware options, and extensometer configuration parameters are all located
in this box.

3-4.1.1 Identification
The “Name” property is the alphanumeric designation for the selected RSU.
This is the same “Name” the ExtensMon program will associate with data
from this unit in its graphical displays.  A meaningful name is suggested, but
not required.

The “Radio ID” property refers to the ID number of the data radio inside the
RSU. When ExtensBase has a message for the selected RSU, this number is
used to address the message to the correct unit. Valid radio ID numbers range
from 1 to 255. Consult the documentation provided with the RSU or call the
technical support team to determine the correct radio ID.

3-4.1.2 Temperature Limits
The “Limit Thresholds” box contains fields for “Temp Hi Limit” and “Temp
Lo Limit.” Each of these properties may range from -15 degrees to 160 F degrees.
If the temperature falls below the lower threshold, the window (on the
ExtensBase Main screen) will turn blue. If it goes above the upper threshold,
the window will turn red.  A message is sent to ExtensMon when the temperature
at the RSU exceeds these limits or returns to normal from a temperature
exception condition. The ExtensMon program then notifies all designated
parties, provided a temperature alarm has been set up (Ch. 4, Sec. 4-6).

3-4.1.3 Battery Limits
The “Limit Thresholds” box also contains fields for “Batt Hi Limit” and
“Batt Lo Limit.” Each of these properties may range from 10 volts to 15
volts. If the voltage falls below the lower threshold, the window will turn
blue. If it goes above the upper threshold, the window will turn red.  A message
is sent to ExtensMon when the battery voltage at the RSU exceeds these
limits or returns to normal from a battery voltage exception condition. The
ExtensMon program then notifies all designated parties, provided a battery
voltage alarm has been set up (Ch. 4, Sec. 4-6).
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3-4.1.4 Sleep Control
The “Sleep Mode” feature is used to shut down the radio in the RSU to
conserve power. Monitoring of ground movement continues in sleep mode,
and the RSU will automatically wake up if excessive ground movements are
measured (i.e., if “Hi-Res” mode is entered).

The “Sleep Mode” may be either enabled or disabled. The radio is left on all
the time when “Sleep Mode” is disabled, so use this mode only for bench
testing and system diagnostics. The “Sleep Mode” should always be enabled
for normal operation to avoid draining the battery.

When “Sleep Mode” is enabled, the RSU is programmed to automatically
wake up (turn on its radio) at a given interval from its last communication
and send a message to ExtensBase. This enables messages that are waiting
to be sent to the RSU to be processed.

The maximum length of time that the selected RSU may remain asleep is
expressed in minutes and is found in the “Max Sleep Mins” box.  Sleep time
may be set anywhere from 1 to 255 minutes.  Sleep time should be equal to
the sample interval multiplied by the packet samples (Sec. 3-4.2.1).

3-4.1.5 Hardware Options
The checkboxes in the “Options” box should be checked if the given device
is included among the hardware components of the selected RSU. The
extensometer is the actual device used for measuring ground movement. If
this box is unchecked, ExtensBase will not look for ground movement data
from the selected RSU.

The RSU may also contain a GPS receiver in some applications. If a GPS
receiver is contained within the RSU enclosure, the “GPS” box should be
checked. If the RSU is equipped with a warning device, such as a siren and/or
flashing light, the “Warning Device” box should be checked.

Once these checkboxes have been correctly configured, they should not be
altered except at the direction of the technical support team.

3-4.2 Extensometer Properties
The remaining RSU properties listed in the “Extensometer” box of the “RSU
Properties” window pertain to sampling intervals, Hi-Res trigger, and the
wire reserve limit. Sampling parameters affect the resolution of the data and
the performance of the system. The Hi-Res trigger is used by the RSU to
determine when the high-resolution reporting mode is called for. The wire
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reserve limit is the estimated length of wire remaining on the supply spool.
A warning can be set up to advise when the spool is close to empty and
should be replaced.

3-4.2.1 Routine Sampling
There are two routine sampling parameters located in the “Extensometer” box.
The “Sample Interval” specifies the length of time in minutes between routine
displacement reports. The value of this parameter will vary depending on the
application. The “Sample Interval” may range from 1 minute to 300 minutes.

The “Packet Samples” parameter indicates the number of displacement
measurements the RSU should store before it transmits to ExtensBase. Valid
entries range from 1 sample to 64 samples per packet (transmission). This
setting affects the transmission frequency from the RSU and hence the
performance of the system. The smaller the number, the more often the unit
will transmit. However, there is a risk of draining the battery if the unit
transmits too frequently, using power more quickly than the solar panel
recharges it.  If the battery voltage drops to 9.5, the unit will shut down.

If the “Sample Interval” is set to ten minutes and the “Packet Samples”
parameter is set to three per transmission (3 per TX), then the RSU will send
out one packet containing three ground displacement measurements every
thirty minutes.

Sending multiple readings in each packet this way conserves RSU power
and improves overall RF system throughput, but has the disadvantage of
fewer real-time updates. The data settings displayed by the example on
Figure 3-20 generate data up to 30 minutes old.

3-4.2.2 Hi-Res Mode
The RSU offers two reporting modes, standard and high-resolution. The
standard mode is used when the ground is moving very slowly. When ground
movement exceeds a preset trigger value (the “Hi-Res Trigger Velocity”)
the RSU goes into high-resolution reporting mode and will send displacement
measurements at an accelerated rate. Valid trigger velocities range from 0.5
to 500 units per day.

A separate pair of sampling parameters (“Hi-Res Sample Interval” and
“Hi-Res Packet Samples”) is provided to enable better sample resolution
and near real-time display during periods of rapid ground movement.  The
“Sample Interval” may range from 1 minute to 300 minutes. Valid entries
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range from 1 sample to 64 samples per packet (transmission).  The RSU
returns to its standard sampling settings once the movement rate falls below
the high-resolution trigger value.

The RSU monitors ground displacement every six seconds.  In order to enter
Hi-Res mode, there must be ten consecutive observations above the Hi-Res
trigger velocity.  In order to exit Hi-Res mode, there must be ten consecutive
observations below the Hi-Res trigger velocity.  This reduces the chance of
switching into Hi-Res mode as a result of wind noise or other external factors.

3-4.2.3 Wire Reserve Limit
The “Wire Reserve Limit” contains a field for the estimated amount of wire
contained on the supply spool, in feet or meters.  A message is sent to
ExtensMon when the wire reserve limit value is exceeded.  If a reserve limit
warning has been set up (Ch. 4, Sec. 4-6), the ExtensMon program will
notify all parties specified.  When the reserve limit is exceeded, there is very
little wire remaining on the supply spool, and it should be replaced with a
new spool of wire.
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SlideMinder® System
Chapter 4.  ExtensMon

4-1. RUNNING EXTENSMON

To start the ExtensMon program, double-click on the ExtensMon icon or
select ExtensMon from the Windows Start menu.  A splash screen will be
displayed briefly, followed by the main program window.  If ExtensMon is
located in the Startup directory, the program will start automatically every
time the system is rebooted.

4-1.1 Splash Screen
The ExtensMon splash screen is displayed on program startup and contains
important point-of-contact information for the technical support team.

To display the splash screen and view technical support contact information
at any time, select the “About” option from the ExtensMon Help menu.

4-1.2 Main Window
The ExtensMon main window
provides menu options to access
all program functionality, a
toolbar with shortcuts to
commonly used functions, a
display area for graphs of
extensometer data, and a status
bar with time, date, connection
status, and warning monitoring
status.

Figure 4-1.  ExtensMon Splash Screen

Figure 4-2.  ExtensMon Main Window
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For details regarding ExtensMon program configuration, consult Section 4-2
below.  Instructions relating to routine ExtensMon operations, such as database
creation, printing, and connecting to ExtensBase may be found in Section 4-3.
Section 4-4 describes common extensometer data maintenance tasks, and
Section 4-5 describes the ExtensMon data analysis features.  Section 4-6 details
the ExtensMon warning features.

4-2. PROGRAM SETTINGS

The ExtensMon program must be configured for proper operation the first
time the program is activated. Program settings for ExtensMon
communications are found on the “Program Settings” window and are covered
in Section 4-2.1.  Program settings relating to ExtensMon program appearance
are described in Section 4-2.2.

4-2.1 Settings Window
To access the ExtensMon settings for program
communications, click on the “Program Settings” option
of the main window’s File menu.

The “Program Settings” window should appear.  If the
“Program Settings” option is grayed out (disabled), an
ExtensMon database is open and must be closed before
program settings can be modified. Consult Section 4-3.2
for instructions on closing the open database.

4-2.1.1 General Settings Tab
The ExtensMon server must be
told the location of the
ExtensBase program in order to
enable data communication.
The “General Settings” tab
contains these settings as well
as settings for warning message
communication.

Enter the IP address, or machine
name, of the computer running
the ExtensBase program in the “IP Address” box.  (See Chapter 3, Section 3-2.3
for obtaining a computer’s IP address.)

Figure 4-3.  File Menu
Program Settings

Figure 4-4.  General Settings Tab
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If no IP address is entered, the
program assumes that the
computer is a client server and
does not allow it to communicate
with the ExtensBase program or
issue warnings.  An “Update
Interval” box at the lower left is
visible while the IP address field
is blank.  A number entered in
“Update Interval” field configures
the time in minutes (from 1 to 20)
that the client will check the database for updates and refresh the display.  If a
“0” is entered, the screen must be refreshed manually using either the “Refresh”
button or choosing “Refresh” from the Plot Type menu.

Communications between the ExtensBase program and the ExtensMon master
program, and also between the ExtensMon master computer and its client

computers, requires that specific port
setting values be used, in addition to
IP addresses or machine names. By
default, the programs are assigned
certain port values that will function
properly. However, if another
program on your computer is using
one of the assigned values, these port
settings may need to be modified.

The TX and RX ports are used only between the ExtensBase program and the
ExtensMon main program. The ExtensMon Warnings port is used by the
ExtensMon main program to issue popup warnings to any ExtensMon client
computer on the same LAN network. ExtensBase port settings are discussed in
further detail in Chapter 3, Section 3-2.3.

4-2.1.2 Mail Settings Tab
A sender’s name, e-mail address, and
e-mail server address (SMTP) must be
specified for outgoing e-mail alerts.
The source name and e-mail address
will appear in the “From” field on all
e-mail alert messages generated by
ExtensMon.

Recommended Port Setting Values

Port Name Port Value

ExtensBase TX port 1194
ExtensBase RX port 1195

ExtensMon Listen (RX) port 1194
ExtensMon Send (TX) port 1195
ExtensMon Warnings port 1197

Figure 4-5.  General Settings Tab

Figure 4-6.  Mail Settings Tab
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In the “Sender Name” box, enter the name that will appear in alert messages.
Enter the e-mail address in the “Sender Address” box. This address will be
used if the recipient of an alert message clicks “Reply.” Finally, enter the URL
for the outgoing (SMTP) e-mail server. (The URL may be obtained either
from the ISP or your company IT personnel.)

4-2.1.3 Modem Settings Tab
Any standard AT-compatible modem may be installed to enable ExtensMon
to send warnings using a pager. If a modem is installed, select the “Modem
Settings” tab on the “Program Settings” window to configure ExtensMon for
modem communications.

Enter the number of the COM port used by the modem in the “Modem Comm
Port” box, or zero (0) if no modem is installed. If using an internal modem,
select the “Phone and Modem
Options” (or similar) applet from the
Windows Control Panel and click on
the “Modems” tab. The modem
COM port will be listed in the table
under the “Attached To” heading.

4-2.2 Program Appearance
The ExtensMon window may be maximized or resized as needed. If more
viewing area is needed in the ExtensMon main window, the toolbar and status
bar may both be hidden using the View menu.  Other appearance settings
relating to graph colors and other ExtensMon data display features may be
found on the “Options” window.  See Section 4-5.1 for further details.

4-2.2.1 Toolbar and Status Bar
The ExtensMon main window toolbar and status bar can be turned on and off
using the “Toolbar” and/or “Status Bar” options in the ExtensMon main
window View menu.  These bars are visible when a checkmark appears next
to their names in the
View menu.  Clicking on
the name in the menu
toggles the bar on or off.

Figure 4-8.  Show/Hide Toolbar and Status Bar

Figure 4-7.  Modem Settings Tab
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4-3. FUNDAMENTALS

Routine ExtensMon operations include creating and opening the central
database, printing the current display, connecting to the ExtensBase program,
and using the help menu.

4-3.1 Create/Select Database
A new database must be created, or an existing database opened before any
ExtensMon data analysis operations can be performed. If the ExtensMon
program is installed as the SlideMinder system data server, then a new central
database must be created before the SlideMinder system can store SlideMinder
system data.

4-3.1.1 Create a New Database
Before any data may be collected by the ExtensMon
server or analyzed using ExtensMon client, a central
database of extensometers and ground movement data
must be created. To create a new database, select the
“New” in the File menu of the ExtensMon main window.

A standard Windows file dialog will open. To create the
new database, enter a name for the database in the “File
name:” box and click on “Open.”

The units of measurement in use
by the SlideMinder system must
be specified when creating a
new database.  Select Metric or
Imperial units when prompted.

Once the central database has been created, the ExtensMon server must be
connected to ExtensBase (Sec. 4-3.4) and must be left running at all times to
process and store the data transmitted by ExtensBase.  The central database
will not start collecting SlideMinder system data until the extensometers have
been added. New extensometers are automatically added when detected in
the data coming from ExtensBase.

Figure 4-10.  Name New Database
Figure 4-11.  Specify Units of

Measurement

Figure 4-9.  Select New
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4-3.1.2 Open an Existing Database
The central database file must be opened before ExtensMon can be used as
a SlideMinder system client. It may also be necessary to open a database file

to analyze archived data or
data from other SlideMinder
installations.

Select the “Open” option
from the ExtensMon main
window File menu. A
standard Windows file
dialog will appear. Navigate
to the appropriate folder and
select the desired database
file. The database file must
have an “.mdb” extension.

Click the “Open” button to open the
selected database file. When the
database file is opened, the
ExtensMon main window will show
a displacement graph of all
extensometers in the database as its
default display.

4-3.2 Close Current Database
Only one ExtensMon database may be open at a time. To view data from a
database other than the current database, the current database must first be
closed. It is also necessary to close the current database before the program
settings can be modified (Sec. 4-2).

To close the current database, select the “Close” option from the ExtensMon
main window File menu.

Figure 4-12.  Opening an Existing Database

Figure 4-13. Main Window, Open Database
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4-3.3 Compact Database
Occasionally the Microsoft Access database the program
generates may become corrupted for various reasons.  With
no database opened, choose the “Compact Database” option
on the File menu.  Select the corrupted database to repair
the file.  Then reopen the database.

4-3.4 Print Current Display
To print the current display, select the “Print” option from
the ExtensMon main window File menu. When this option is
selected, the current graph will be sent to the default printer.

4-3.5 Most Recently Used File List
Once a database has been opened, a shortcut
will appear on the File menu.  Click on the name
of the database instead of searching for it on
the hard drive.  The four most recently used
databases are shown.

4-3.6 Connect to ExtensBase
A live connection between the ExtensMon server and the ExtensBase is required
for transfer of extensometer data from the remote units to the central database.
If the ExtensMon program has been installed as the central server and the main
window status bar says “Not Connected,” connection to the ExtensBase program

must be established.  Select the “Connect
to ExtensBase” option from the Acquire
menu or use the “Connect to Base” toolbar
button to establish the connection.

When ExtensMon is connected to
ExtensBase, the word “Connected” will appear in the main window status bar.

Consult Chapter 5, “Troubleshooting,” regarding any connectivity problems.

Only the ExtensMon server is required to have a live
connection to ExtensBase; ExtensMon clients should
remain disconnected from ExtensBase.

Figure 4-17.  “Connected” Status Bar Display

Figure 4-14.
Compact Database

Figure 4-16.  The Acquire Menu

Figure 4-15.  Recent File List
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4-3.7 The ExtensMon Help Menu
The ExtensMon Help menu may be used to access
this user’s guide through the “Contents” and “Search
For Help On…” options.  Select the “About” option
to bring up the splash screen with point-of-contact
information for the technical support team.

4-3.8 The Toolbar and Status Bar
The ExtensMon program toolbar offers shortcuts to some frequently used
program features. Toolbar shortcuts are only active when a database is open.

The toolbar shortcuts functions are (from left to right):
• Create new database • Connect to base
• Open existing database • Refresh current display
•     Closes existing database                      •     Hours for moving average
• Print current display

The “hours for moving average” box is used to enter the number of hours
over which velocity data should be averaged.  See Section 4-5.1.3 for more
information on this setting. The toolbar is the only location for the “Refresh”
button, so the toolbar must be visible to force the display to refresh.

The ExtensMon program also features a status bar at the bottom edge of
the main window.  The status bar is used to display the status of the connection
to ExtensBase, the warning monitoring status, and current date and time.

The ExtensMon server should always show “Connected” and “Monitoring
Warnings” messages in the status bar.  Consult Chapter 5, “Troubleshooting,”
if the ExtensMon server status bar reads “Not Connected” or “Not
Monitoring Warnings.”

The ExtensMon server is typically left running at all times, and is the only
ExtensMon that should be monitoring warnings.

Only the ExtensMon server that maintains the central
database of extensometers and movement data should
be Connected to ExtensBase.

Figure 4-19.  The ExtensMon Toolbar

Figure 4-18.  The Help Menu

Figure 4-20.  The ExtensMon Status Bar
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4-4. EXTENSOMETERS

The ExtensMon program depends on the extensometer data in the central
database for correct operation. The central database must be kept up-to-date
with relevant information regarding all installed extensometers, including
warning devices, radio ID, and geographical location. Procedures for
maintaining extensometer data, as described in the following subsections,
require a database to be open.

4-4.1 Extensometer Table
A list of all extensometers in the current database may be
obtained by selecting the “Tables” option from the View
menu.  The “View Tables – Extensometers” window,
containing a detailed listing of every extensometer in the
current database, will open.

By default the extensometers list is presented. Extensometer parameters
shown in this table include station ID, radio ID, location ID, station name,
display color, warning status, encoder presence, warning devices, and a
“station active” indicator.

Other tables may be viewed by selecting the various tabs.  Extensometer Data
shows the date and time, displacement, voltage, and temperature values.
Individual lines may be deleted by checking “Allow Deleting Rows,”
highlighting the row with the pointer, and pressing the “Delete” key on the
keyboard. Historical data may be viewed for locations, limit settings, and
deactivated units. Switch between extensometers by selecting from the list on
the right side of the window.

Figure 4-21.
Select View/Tables

Figure 4-22.  Detailed Listing of Extensometers
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4-4.2 Extensometer Tools
The Tools menu of an ExtensMon Open Database
main window lists options to select, modify,
reactivate, or delete Extensometers.

4-4.2.1 Select Extensometer
The “Select Extensometer” window is used for
a number of ExtensMon features, such as
reactivating or deleting extensometers.  The
data displayed on the ExtensMon graphical
display is determined by the selected
extensometers. Only data collected by the
extensometers that have been selected for
display will be shown on the graph.

On the Tools menu, click on “Select
Extensometer” to display the list of
extensometers.  By default the list displays only
active extensometers.  To include inactive
extensometers, check the “Show Deactivated
Stations” box on the bottom left.

Click on the name of the extensometer to select it. To select more than one
extensometer, hold down the control (“Ctrl”) key on the keyboard while clicking,
or click an extensometer then hold down the shift key and click another
extensometer to select all extensometers between the two.  The “Select All”
button can also be used to select all the extensometers listed. The “Deselect All”
button is used to clear the current selection. When all desired extensometers
have been selected, click “OK” to accept the selection. Click “Cancel” to
abort the selection process and close the “Select Extensometer” window.

4-4.2.2 Modify Extensometer
When it becomes necessary to
change the operational parameters
for an extensometer, select the
“Modify Extensometer” option from
the Tools menu. The “Update
Extensometer” window will open.

From the “Name” drop-down menu,
select the extensometer to be
modified. The current settings for

Figure 4-24. Select Extensometer

Figure 4-23.  Tools Menu

Figure 4-25. Update Extensometer
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the selected extensometer will be displayed. Update the extensometer
location, equipment, comments, and color parameters as necessary. Click
“Apply” to accept the changes without closing the window, “OK” to accept
the changes and close the window, or “Cancel” to close the window without
accepting the changes.

The location and direction parameters are required for the vector plots. The
“Location” refers to the northing, easting, and elevation of the extensometer;
the “Direction” parameter should be the approximate azimuth, in degrees, of
the wireline in the field, from the extensometer to the anchor pin. These
parameters are required by ExtensMon for correct display of displacement
vector and velocity vector plots. If these parameters are omitted, the vector
plots will not be accurate.

To deactivate the extensometer, click the “Deactivate” button. The deactivated
unit will no longer appear by default.  The data will be retained in the database
and can be viewed by checking the “Show Deactivated Stations” box in the
Select Extensometer window.

For ExtensMon client programs, it is
possible to modify extensometer
colors.  From the Tools menu, choose
“Modify Extensometer.” A new
window titled “Override Colors” will
open. The color of the extensometer
as it appears on the master computer
will be shown. In order to change to
a new color, the “Use New Colors”
box must be checked.  Click the “Change Color” button to open a color palette
and select a new color.  Once a color is selected, click “Done.”  To deselect the
new color, click on “Remove,” or to toggle between the new and original color,
check or uncheck the “Use New Colors” box.  To switch to a different
Extensometer, use the drop-down menu and select the desired unit.

4-4.2.3 Reactivate Extensometer
To reactivate an extensometer that has been deactivated, select “Reactivate
Extensometer” from the Tools menu. The Reactivate feature uses the “Select
Extensometer” window (Sec. 4-4.2.1).  By default, a list of all inactive
extensometers will be displayed.  Select the extensometers to be reactivated
and click “OK.” Click “Cancel” to abort the reactivation.

Figure 4-26. Override Colors
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4-4.2.4 Delete Extensometer
To delete extensometers, select the “Delete Extensometer” option from the
Tools menu. A list of all extensometers will be displayed. Select the
extensometers to delete (Sec. 4-4.2.1) and click “OK” to delete the selected
extensometers or “Cancel” to abort the deletion.  All data associated with the
deleted unit will also be deleted.

4-4.3 Extensometer Status
To view the current status of all extensometers in the
database, select the “Ext Status” option from the main
menu. The “Extensometer Status” window will open. The
box in the left half of the window contains a tree view
that lists all extensometers stored in the current database.

Branches of the tree view may be collapsed/expanded as necessary for more
convenient viewing. For each extensometer in the currently open database,
the status is displayed for:

• name
• location
• last known direction

of movement
• displacement
• velocity
• battery voltage

The warning indicator beside the name of the unit is normally green. If the
unit contains a warning device, and the device is active, the warning indicator
will be red.

To enable or disable an extensometer, or to turn extensometer warning devices
on or off, select an extensometer in the tree view on the left, then right click
on the label.  A new menu will open.  Select the desired action.

NOTE:  To use this feature, ExtensMon must be connected to ExtensBase.

Under normal operations, it is preferable to deactivate
an extensometer, rather than delete it.  Deletions should
only be used for testing purposes.

Disabling an active warning device may not take effect
immediately, depending on the sleep settings of the
particular unit.   The warning device will  not be
deactivated until the unit checks in with the base station.

Figure 4-27. Ext Status

Figure 4-28. Extensometer  Status Window
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4-5. DATA ANALYSIS

The primary function of the ExtensMon program is the analysis of ground
movement data. The ExtensMon program offers two types of data display:
vector plots in plan view and graphs of change over time.  Analysis operations
include setting data display options, selecting ranges, selecting display type,
and working with the display.

4-5.1 Set Display Options
All graph and plot display options are set using the
“Options” window.  In the ExtensMon open database
main window, select “Options” from the View menu to
open the “Options” window.  This window has three tabs:
“General Options,” “Displacement,” and  “Velocity.”

4-5.1.1 General Options
The “General Options” tab is used to set foreground and background colors for
plots and graphs, turn gridlines on and off, and select data reduction settings.

Click the “Modify” button next to “Main Plot Background” to change the
background color. A standard windows color palette will open. Use the palette
to select the background color, then click the “OK” button on the palette

window to change the color, or click
“Cancel” to keep the current color.
The new background color will be
displayed in the box beside “Main
Plot Background.” Use the same
procedure to select the color for the
axes and lettering. (Click on “Modify”
beside “Main Axes Color.”)

A check mark in the checkbox to the
left of “Main Plot Gridlines” indicates plot/graph gridlines are on. Uncheck
this box to turn gridlines off.  The “Temperature Display Units,” on the right
side of the screen, can be selected using the drop-down menu.

The “General Options” tab also contains options for data point reduction to
reduce plotting time.  It may also make it easier to spot general trends in the
data if the number of data points is reduced. To turn off data point reduction
and see all of the data points, select the “None” option in the “Data Reduction”
box. To improve the time it takes to display the graph, the “Default” option
may be selected to display a maximum 3,000 data points in the date range.

Figure 4-30.  General Options Tab

Figure 4-29. Options
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To fine tune the number of database
data points between data points on
the graph, select either “Every N
points” or “Every N Hours” and
enter the number of database points
or the number of hours between
display points in the text box.

Under the “Variable” option, three
separate time periods can be
specified and the data reduced,
chronologically, by different variables:

1. Every data point for the most recent data
2. One data point every two hours (12 points/day)

for the period preceding the most recent
3. One point per day for the period preceding that (the oldest data).

4-5.1.2 Displacement Options
The “Displacement” tab of
the “Options” window is
used to define parameters for
vector plots of displacement
data. The relative length of
the displacement vectors may
be changed by multiplying
the actual movement by a
constant (the “Displacement
Multiplier”). The units of the
displacement vectors may be
specified using the “Display Units” drop-down menu.

The displacement vectors may be color-coded by magnitude to make it easier
to determine which extensometers have detected excessive ground movement.
For example, green could be used to designate ground that has barely moved,
yellow for ground that has moved but not so far that it has become a hazard,
and red for ground that has moved far enough to be designated a hazard.

To set a color for a range of ground displacement, use the text box on the
left to enter the maximum displacement value for a given color, then double
click on the box to the right to select the color. A standard Windows color
palette will open. Choose the desired color and click the “OK” button on
the palette window.

Figure 4-31.  Data Reduction by Points

Figure 4-32.  Variable Data Reduction

Figure 4-33.  Displacement Tab
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To accept the color for that
displacement range and create a new
range for larger values, click the
“Add” button. To remove a range
and all ranges below it, delete the
number in the text box on the left
and click the “Modify” button.

4-5.1.3 Velocity Options
The “Velocity” tab of the “Options”
window is used to define parameters
for vector plots of velocity data. The
relative length of the velocity vectors
may be changed by multiplying the
actual rate of movement by a
constant (the “Velocity Multiplier”).
The units of the velocity vectors may
be specified using the “Display
Units” drop-down menu.

The velocity vectors may also be color-coded to make it easier to determine
which extensometers have detected an excessive rate of ground movement.
Follow the procedure outlined in the previous section to set color ranges.

4-5.2 Set Ranges
The options for setting the x and y ranges for graphs of
change versus time are located under the view menu in
the ExtensMon open database main window.  The range
for the y axis (the vertical axis) is set using the “Y Range”
option.  The range for the x axis (the horizontal axis) is
set using the “Date Range” option.

Figure 4-36.
Range Options

Figure 4-34.  Add and Modify Colors

Figure 4-35.  Velocity Tab
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4-5.2.1 Y Range
Select the “Y Range” option on the View
menu to open the “Set Y Range” window.
Enter the minimum and maximum values
for the vertical (y) axis in the “Minimum”
and “Maximum” boxes. The units of
measurement for the y axis limits are
specified in the “Options” window for the
given graph type.  To maximize the Y Range,
check the “Use Full Range” check box.

4-5.2.2 Date Range
Select the “Date Range” option on the View menu to open the “Set Date
Range” window. Click the “Maximum Extents” button to select all available
data from the database for the given extensometer and current graph type.

The date range displayed on the x axis may be narrowed by manually setting
the start and end date and time using the “Minimum” and “Maximum” boxes.
Click the down arrow on the date
box to bring up a calendar to select
a date, and use the up/down control
on the time box to set the display
time limit.

Check the “Interval Only” box to
view the graphs in a moving window.
Set the interval in days or months
using the drop-down menu.  As new
data are added, the graph automatically shifts left and shows only the desired
interval of the most current data.  Checking the “Interval Only” check box
overrides any minimum and maximum dates already set.  Uncheck the box to
use a specific date range.

Figure 4-38.  Set Date Range

Figure 4-37.  Set Y Range
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4-5.3 Select Display Type
The ExtensMon program offers two types of data display:

1. Vector plots in plan view:
• Displacement
• Velocity

2. Graphs of change over time:
• Displacement
• Velocity
• Temperature
• Voltage

Vector plots show movement as vectors, with the origin of the vector placed
at the map coordinates of the extensometer.  The relative length of the vectors
can be changed by a vector multiplier (Secs. 4-5.1.2 and 4-5.1.3).

NOTE: Vector and azimuth plots will not display correctly unless the correct
northing and easting of the extensometer have been entered using the “Modify
Extensometer” windows (Sec. 4-4.2.2).

When the mouse pointer is positioned over a vector on a vector plot, a text
box will pop up showing the extensometer label, coordinates, and present
velocity associated with the indicated vector. Plots and graphs can display
data collected from one extensometer or multiple extensometers, depending
on the list of selected extensometers (Sec. 4-4.2.1).

Plots and graphs are accessed under the Plot Type menu
in the ExtensMon main window with an open database.

Screens may be updated or refreshed at any time using
the “Refresh” button on the toolbar or by selecting
“Refresh” from the Plot Type menu.

Figure 4-39.
Plot Type Menu
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4-5.3.1 Displacement vs. Time
To view the ground displacement data collected from the extensometer, select
the “Displacement vs. Time” option from the Plot Type menu.  A typical

displacement graph should show a continuously increasing curve as the ground
slowly moves away from the extensometer.

Data spikes can occur when there is a temporary extension of the wireline. A
false warning condition may also be produced. In most cases, the movement
graph will return to the movement level prior to the spike. The data spikes may
be caused by a high velocity wind gust or a person walking into the wireline.

Figure 4-40.  Displacement vs. Time



CALL & NICHOLAS INSTRUMENTS

NOTES           4-19

4-5.3.2 Velocity vs. Time
To view the incremental velocity measured by the extensometer, select the
“Velocity vs. Time” option from the Plot Type menu.

A typical velocity graph will usually appear as a line centered on a velocity of
zero with spikes occurring when movement is detected.  A value can be entered
on the “hours for moving average” field located on the toolbar to filter the
data noise.  This calculates the velocity over a moving time period of the
specified number of hours.  Decimal values may be used (e.g., 0.1, 4.5, etc.).

Figure 4-41. Velocity vs. Time
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4-5.3.3 Displacement Vector
To view ground displacement vectors derived from extensometer data, select
the “Displacement Vector” option from the Plot Type menu.  A vector plot
will be displayed showing the relative displacement measured by all selected
extensometers.

Figure 4-42.  Displacement Vector
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4-5.3.4 Velocity Vector
To view ground movement velocity vectors derived from extensometer data,
click on the Plot Type menu and select the “Velocity Vector” option. A
vector plot will be displayed, showing the relative rate of displacement
measured by all selected extensometers.

Figure 4-43.  Velocity Vector
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4-5.3.5 Temperature vs. Time
A temperature sensor located inside the extensometer enclosure collects
temperature data. To view the data, select the “Temperature vs. Time” option
from the Plot Type menu.

The graph of temperature versus time should have a daily cycle, with extremes
determined by time of day and weather patterns. Temperature graphs should
be viewed periodically to monitor the physical condition of the extensometer.
Extremely cold or hot conditions may cause failure of certain components.

Figure 4-44. Temperature vs. Time
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4-5.3.6 Voltage vs. Time
The extensometer also reports its battery voltage. To view the extensometer
battery voltage data, from the Plot Type menu, select “Voltage vs. Time.”

The graph of voltage versus time should mimic the temperature graph, with
the voltages varying between 12.5 volts and 13.5 volts. The voltage will
increase during daylight hours when the solar panel is providing power for
the extensometer and charging the battery and will decrease during non-
daylight hours as the battery is slowly drained by the extensometer.

If the voltage graph shows a downward trend, a longer sleep interval may be
required, or the battery may be in need of replacement. If the voltage goes
below 10.5 volts, the extensometer will shut down and will require manual
startup to resume operation. If the battery voltage goes below 10.5 volts,
the charging system should be inspected. The solar panel may need attention,
or the battery may need to be recharged or replaced.

Figure 4-45. Voltage vs. Time
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4-5.4 View the Graph/Plot
When viewing a vector plot or graph, display options include zoom in or out,
refresh, and print.

4-5.4.1 Zoom In/Out
To zoom in on a portion of the display, click and hold the left mouse button
while dragging the mouse pointer diagonally to draw a box around the desired
area.  Right click inside this box and select the “Zoom In” option from the

popup menu.

The x and y axis limits (Sec.
4-5.2) will be automatically
adjusted for the desired zoom
area and the current graph
will be redrawn accordingly.

To zoom back out, right
click anywhere on the
display and select either
“Zoom Previous” or “Zoom
Extents” from the popup
menu. “Zoom Previous” will
redraw the graph to the

previous x and y ranges. “Zoom Extents” will redraw the graph to display all
available data for the current selected extensometer(s) and graph type.

By default, ExtensMon shifts all extensometer data to
zero displacement at the start date.  This can be changed
using the popup menu; right click anywhere on the
display.  “Align End” can be used to normalize the data
to the end date.  “Plot Actual Displacement” will plot
each extensometer using the actual values received from
the encoders.  Select “Align Start” to set zero
displacement at the start date.

4-5.4.2 Refresh
To update, or refresh, the current display to include the most
recent data, click the “Refresh” button on the toolbar or
select “Refresh” from the Plot Type menu. The current
display will be updated to reflect any new data collected
since the graph or plot was last drawn.

Figure 4-46. Zoom In

Figure 4-48.
Refresh Button

Figure 4-47.
Zoom Popup Menu
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4-5.4.3 Print
To print the current display, select the “Print…” option from the ExtensMon
main window File menu.

A standard Windows “Print” dialog will
open. Use this window to select a printer
and specify printing options, then click the
“Print” button to send the graph to the
selected printer.  Click “Cancel” to abort the
print operation.

NOTE:  The “Print” button on the toolbar will send the
current display to print using the default printer and the
last known printer settings.  Use the “Print” option
under the File menu, if you need to verify printer or
print settings.

Figure 4-49. File Menu Print Option

Figure 4-50.
Print Button
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4-6. WARNINGS

The ExtensMon program can be configured for an endless variety of warning
protocols. Warnings can be issued for excessive ground displacement or
velocity, and for battery voltage or temperature above or below preset limits.
Warning messages can be set to display in a message box on another computer,
or they may be sent via e-mail or pager. If an RSU (extensometer) is equipped
with a warning device such as a flashing light or siren, that device can be
automatically activated as part of the warning protocol.

4-6.1 View Warnings
To avoid confusion, the ExtensMon server that maintains the central
extensometer database is the only ExtensMon that should be configured with
warning protocols to issue warnings. The ExtensMon clients should not
implement the warnings unless they are running at all times. Even then, an
ExtensMon client will be unable to activate extensometer warning devices, or
issue “Limit” warnings, because it does not communicate directly with the
ExtensBase program.

To configure ExtensMon warning protocols, in
the Main Window, click on the Warnings menu,
then select “Set Warning.”

A window with a list of all warnings will be
displayed. This “Warnings” window is the
interface used to define, edit, copy, enable, and
disable ExtensMon warnings.

The column on the left,
“Enabled,” displays an “E”
if the warning is enabled, or a
blank space if the warning is
disabled. The “Description”
column shows the alpha-
numeric name for the
warning; the “Type” column
shows whether a warning is
a displacement, velocity, or
limit warning. The final
column indicates the value
beyond which a warning will
be issued.

Figure 4-51.  Set Warnings

Figure 4-52.  The Warnings Window
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4-6.2 Add Warning
To add a new warning, click the
“Add” button on the “Warnings”
window. The “Set Warning
Thresholds” window will open.

Adding a warning is accomplished
in six steps:

1. Name the warning
2. Select type
3. Specify threshold
4. Select extensometer
5. Select delivery method
6. Specify warning message

4-6.2.1 Name the Warning
Enter an alphanumeric designation for the warning in the “Description” box.
This is the name that will appear in the list on the “Warnings” window.

4-6.2.2 Select Warning Type
Select the type of warning.

• A “Displacement” warning will be issued when total ground
movement exceeds a preset limit.

• A “Velocity” warning will be issued when the rate of movement
exceeds a preset limit.

• A “Limit” warning is based on temperature, battery voltage, or
wireline pay out.

Displacement Warning

To set a displacement warning, click the “Displacement” option under “Type.”
Enter a numeric value in the “Value” box and select the unit of measurement
for that value from the “Units” drop-down menu.  (Fig. 4-51 shows a value of
ten inches.)

Figure 4-53.  Set Warning Threshold

Figure 4-54.  Set Warning Threshold - Displacement
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Select one of the three time periods from the “Time Period” drop-down menu.
Enter the required start date and time in the “Date/Period” box if the “Since
Date” time period was selected, or enter the number of hours if the “Last
Hours” time period was selected. If the “Last Hours” period is selected,
ExtensMon will only look at the accumulated displacement over the preceding
number of hours specified in the “Date/Period” box.

Velocity Warning

To set a velocity warning, click the “Velocity” option under “Type.” Enter a
numeric rate in the “Value” box, and select the units for that rate from the
“Units” drop-down menu. (Fig. 4-52 shows a warning threshold value of twelve
inches per day.)

Enter the number of hours over which to average the velocity readings in the
“Average Time” box. The velocity that is compared by ExtensMon to the
threshold value is the calculated velocity from the current reading to the reading
at the beginning of the “Average Time” period. This “moving average” is
necessary to smooth out the data spikes that occur in the data.

Limit Warning

A “Limit” warning is issued when battery voltage, temperature, or wireline
exceeds a given limit or returns to normal from an exception condition. To set
a limit warning, click the “Limit” option under “Type,” then select “Voltage,”

Figure 4-55.  Set Warning Threshold - Velocity

Figure 4-56.  Set Warning Threshold - Limit
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“Temperature,” or “Wireline Limit” from the options that appear in the box
below the Type box.

Select a warning type from the “Type” drop-down menu.  The “Above” warning
is issued when the monitored parameter exceeds the “Max” value specified in
the ExtensBase “RSU Properties” window.  The “Below” warning is issued
when the monitored parameter exceeds the “Min” value specified in the
ExtensBase “RSU Properties” window.  A “Return to Normal” warning is
issued when the parameter returns to normal after being above the maximum
or below the minimum.

The temperature and battery limits must be programmed into the RSU
(extensometer) using the ExtensBase program before any ExtensMon “Limit”
warnings can be issued.  For further details regarding temperature and battery
limits, see Chapter 3, Sections 3-4.1.2 and 3-4.1.3, respectively.  The wireline
limit (also called the “wireline reserve limit”) is described in Chapter 3,
Section 3-4.2.3.

4-6.2.3 Select Extensometers
Select the extensometers to which the warning will apply.  Click the “Select
Extensometer(s)” button to open a new window. Select the desired units for
the warning being created.  Multiple units can be selected by holding down
the “ctrl” key and clicking the additional extensometers, or all units can be
selected using the “Select All” button.

4-6.2.4 Select Delivery Method
The delivery methods must be specified for the
warning. Use the check boxes under “Warning
Type” to select warning delivery methods. The
warning may be sent by message box, e-mail,
and pager. The warning devices on the
extensometer can also be activated. The delivery
methods are not mutually exclusive; all delivery
methods may be selected for a given warning.

Figure 4-57.  Warning Types
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Send Warning by Message Box
To send alert messages by message box, check
the “Message Box” check box under “Warning
Type.” In the lower right-hand corner of the “Set
Warning” window, select the “Message Box” tab.
Enter the text of the warning message in the
“Message” text box. When the warning is
activated, a message box containing this text will
appear on the monitor of any computer listed in
the “Warnings To” box under the “General
Settings” tab of the “Program Settings” window
(Sec. 4-2.1.1).

Send Warning by E-Mail
To send alert messages by e-mail, check the
“Email” check box under “Warning Type.” In the
lower right-hand corner of the “Set Warning”
window, select the “Email” tab. Enter the address
of the warning recipient in the “Address” text box
and the text of the warning message in the
“Message” text box. When the warning is
activated, an e-mail containing the specified text
will be sent to all of the listed addressees. The
sender’s name and return address will appear as
specified under the “Mail Settings” tab of the
“Program Settings” window (Sec. 4-2.1.2).

Send Warning by Pager
To send alert messages by pager, check the “Pager”
check box under “Warning Type.” In the lower
right-hand corner of the “Set Warning” window,
select the “Pager” tab. Enter the phone number of
the pager in the “Pager #” text box and the numeric
warning message in the “Numeric Message” text
box.  When the warning is activated, the pager at
the given phone number will be dialed and the
numeric warning message will be transmitted. Only
one pager number may be specified per warning.

Figure 4-58.  Message Box Tab

Figure 4-59.  E-mail Tab

Figure 4-60.  Pager Tab
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Activate Remote Warning Devices
To have the warning activate remote warning devices
such as a siren or flashing lights, check the “Warning
Device” check box under “Warning Type.” In the
lower right-hand corner of the “Set Warning”
window, select the “Warning Device” tab. Select the
desired extensometers from the list box. When the
warning is activated, a command to activate warning
devices will be transmitted to each selected unit.  To
deselect a warning device, hold down the “Ctrl”
button and click on the device name.

NOTE: Only those units that are equipped with
warning devices will appear in the list box under the “Warning Device” tab.
Units that are equipped with warning devices must be specified in the
ExtensBase program (Ch. 3, Sec. 3-4.1.5). A direct connection to the
ExtensBase program is required to activate remote warning devices;
ExtensMon clients cannot be configured to use this feature.

4-6.2.5 Save the Warning
When configuration of the new warning is
complete, click the “Save” button to save changes
or “Cancel” to discard the changes and close the
window.

Once changes are saved, write the new warning
thresholds to the database. In the ExtensMon main
window, select “Save Thresholds” under the File
menu.  The new warning thresholds and all
associated warning parameters will be permanently
written to the database.

NOTE: No confirmation dialog is displayed; be
sure the thresholds are set correctly before
selecting the “Save Thresholds” option.

4-6.3 Modify Warning
Once warnings have been added to the database, they may be edited, activated,
deactivated, or deleted. To change warning parameters, open the ExtensMon
main window.  Click on the Warnings menu and select “Set Warnings” to
bring up the “Warnings” window. (Fig. 4-49)

Figure 4-61.
Warning Device Tab

Figure 4-62.  Save Thresholds
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4-6.3.1 Edit Warning
To modify a warning, select the desired warning from the list in the “Warnings”
window and click the “Edit” button. The “Set Warning” window will open
with all the details relating to the selected warning. All warning parameters
and delivery methods may be modified except the warning type (displacement,
velocity, or limit).

When editing is complete, click the “Save” button to save changes or “Cancel”
to discard the changes and close the window. After completing and saving
edits, write the changes to the database.  Select “Save Thresholds” under the
File menu (Sec. 4-6.2.5).

4-6.3.2 Copy Warning
New warnings can be created by copying from an existing warning and editing
as necessary.  In the “Warnings” window, select the warning to be copied and
click the “Copy” button.  A copy will be created and appear in the list.  Select
this new warning and make the desired edits.

4-6.3.3 Enable/Disable Warning
The Enable/Disable button is a toggle switch.  If a warning is enabled, clicking
on this button will disable it, and vice versa. Warnings that are enabled will be
indicated by an “E” in the far left-hand column of the “Warnings” window.
Warnings that are disabled will have a blank space in that column. To toggle a
warning on or off, select the desired warning from the table and click the
“Enable/Disable” button.

4-6.3.4 Delete Warning
To delete a warning, select the desired warning from the table and click the
“Delete” button. NOTE: This is a one-click process; no confirmation dialog
will be displayed.  Be certain that the selected warning is the correct one.

4-6.4 Monitor Warnings
The ExtensMon server will send warning messages
only when warning monitoring is turned on. Warning
monitoring can only be turned on at the  ExtensMon
server. In the ExtensMon server, click on “Warnings.”
A check next to “Monitor Warnings” indicates that
ExtensMon is monitoring incoming data for exception

conditions and will send out the specified warning if activated. The absence of
a check next to the “Monitor Warnings” option indicates that ExtensMon is
not checking for warning conditions.

Figure 4-63.
Monitor Warnings
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The status bar will read “Monitoring Warnings” in the panel immediately to
the right of the “Connected” panel when warnings are being monitored. If
warnings are not being monitored, the warning monitoring status bar panel
will read “Not Monitoring Warnings.”

Warnings that activate a remote warning device and are no longer needed can
be turned off using the “Ext Status” function of the ExtensMon server’s main
menu. (See Section 4-4.3 for more information on the “Extensometer Status”
feature.)  Alternatively, when displacement rates fall below the trigger
threshold, the warning device will turn off automatically.

Figure 4-64.  Monitoring Warnings Status
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SlideMinder® System
Chapter 5.  Troubleshooting

5-1. EXTENSBASE

The ExtensBase program controls communications with the Remote Station
Units (RSUs), otherwise known as extensometers. If a GPS module is installed
at the base station, ExtensBase also maintains accurate system time using
the GPS receiver. The ExtensBase program also relays all RSU ground
movement data to the ExtensMon server program for storage in the central
database. Consult the following sections if problems are encountered with
any of these subsystems.

5-1.1 No Base Radio
The following message box will be displayed when ExtensBase is started if
the base station radio is disconnected.

The base station radio must be initialized when ExtensBase is started.  If this
message is displayed, click “Abort” to cancel ExtensBase startup, or follow
the troubleshooting procedures, then click “Retry.”

The base station radio may also become inoperative
after ExtensBase has been started, in which case a “NO
BASE RADIO” message will appear in the main
ExtensBase window.

If the “Base Radio Error” message box opens, or if
the “NO BASE RADIO” message is present, proceed
with the following steps to ensure that the base station
radio is connected and properly functional.

• Ensure that the base station radio power supply is plugged into an
outlet and properly connected to the base station radio (see the
SlideMinder hardware manual for details).

• Check the serial cable from the base station radio to the computer
where the ExtensBase program has been installed. Inspect the cable
for damage and proper connection on both ends. If the serial cable is
damaged, order a new one from the technical support team.

Figure 5-2.
No Base Radio

Figure 5-1.  Base Radio Error
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• Remove the small plastic door on the right front of the base station
radio to view the base station radio status LEDs (Light Emitting
Diodes). At least one of the LEDs should be illuminated. If no LEDs
are illuminated, the base station radio may have to be replaced.

• If the power supply is properly connected and the LEDs are not
illuminated, check the circuit breaker or fuse for the outlet where the
base station radio is plugged in. Proper outlet functionality may also
be verified by plugging in a known good device, such as a lamp.

• If the power outlet is functional, but the base station radio LEDs are
not illuminated, then the problem is most likely a bad power supply.
Order a new power supply from the technical support team.

• Ensure that the base station radio antenna feed line is undamaged
and properly connected to the back of the base station radio (see the
SlideMinder hardware manual for details).
NOTE: Be sure the antenna is connected before the base station
radio is powered up.

• Check the COM port number on the back of
the computer where the serial cable is
connected. The COM port number on the back
of the computer must match the COM port
number specified in the ExtensBase “RSU
Properties – System Properties” window in the
“Base Radio” box. (Ch. 3, Sec. 3-2.2)

If all of these steps have been followed and the base
station radio remains non-functional, it may have to
be replaced. Please contact the technical support team
for further guidance.

5-1.2 GPS Not Found
Proper SlideMinder system functionality depends on accurate system time.
A system without access to a network having correct time-of-day will have a
GPS module installed. Follow the procedures in this section only if there is
a GPS module installed and system time is inaccurate.

If no GPS module is installed, the entry in the “GPS” box of the “RSU
Properties – System Properties” window (Ch. 3, Sec.3-2.2) must be set to
zero (0). If a GPS module is installed and all other SlideMinder subsystems

Figure 5-4.
RSU Properties
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are functional and connected, but no data is being collected, then the
problem may be with the GPS module.

If there is a problem with the GPS module, the “ExtensBase Diagnostics”
window may have a “GPS PORT:n FAILED” message (where n is the COM
port number of the GPS module) similar to the following illustration. (Fig. 5-5)
Contact technical support for information regarding accessing the ExtensBase
Diagnostics window.

If ExtensBase has been
active for more than a few
minutes, the “GPS PORT:n
FAILED” message may
have already scrolled off the
top of the viewable list of
messages. If this is the case, shut down and restart the ExtensBase program.
Open the “ExtensBase Diagnostics” window immediately upon startup and
look for the “GPS PORT:n FAILED” message near the top of the display.

The “GPS PORT:n FAILED” message indicates that the COM port number
supplied in the “RSU Properties – System Properties” window is an invalid

COM port number and cannot be
accessed. The technical support team
can help determine what serial ports
are available for GPS module usage.

A similar but
different message appearing in the
“ExtensBase Diagnostics” window
during system startup is the
“CANNOT OPEN GPS PORT:n”
error, where n is the COM port
number specified in the “RSU
Properties – System Properties”
window for the GPS module.

The “CANNOT OPEN GPS PORT:n” error indicates that the COM port
specified for the GPS module is already in use by another device. If this is
the case, remove the other device or specify a new GPS port. Contact the
technical support team for further guidance if the problem persists.

Figure 5-5.  Diagnostics - Bad GPS Port

Figure 5-6.  Diagnostics –
Can Not Open GPS Port
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If neither of the above error messages are detected, but system timing
problems are still indicated, there is a problem with the GPS module itself.
Proceed with these steps to ensure that the GPS module is connected and
properly functional.

• Ensure that the GPS module power supply is plugged into an outlet
and properly connected to the GPS module (see the SlideMinder
hardware manual for details).

• Check the serial cable from the GPS module to the computer where
the ExtensBase program has been installed. Inspect the cable for
damage and proper connection on both ends. If the serial cable is
damaged, order a new one from the technical support team.

• If the power supply is properly connected, check the circuit breaker
or fuse for the outlet where the GPS module is plugged in. Proper
outlet functionality may also be verified by plugging in a known
good device, such as a lamp.

• If the power outlet is functional, but the GPS module is not, then the
problem may be a bad power supply. Order a new power supply from
the technical support team.

• Ensure that the GPS antenna feed line is undamaged and properly
connected to the back of the GPS module (see the SlideMinder
hardware manual for details).

• Ensure that the GPS receiver has a clear view of the sky and is not
covered with debris or snow.

• Check the COM port number on the back of the
computer where the serial cable is connected.
The COM port number on the back of the
computer must match the COM port number
specified in the ExtensBase “RSU Properties”
window in the “GPS” box (Ch. 3, Sec.3-2.2).

If all of these steps have been followed and the GPS
module remains non-functional, the GPS module may
have to be replaced. Contact the technical support team
for further guidance.

Figure 5-7.
RSU Properties
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5-1.3 RSU is Sleeping
When RSU (extensometer) properties are updated, the distance is set, or an
attempt is made to “read” the RSU, one of the following “RSU Sleeping”
message boxes may appear.

This in itself is not necessarily a problem. When the RSU “Sleep Mode” is
enabled (Ch. 3, Sec.3-4.1.4), ExtensBase will be unable to communicate
with the given RSU for a period of
time up to the limit specified in the
“Max Sleep Mins” box under “Sleep
Control” in the “RSU Properties -
RSU Properties” window.

The “RSU Sleeping” message
indicates a problem only when the
main ExtensBase window reads
“Comm Overdue n Mins,” where n,
which is the number of minutes that communication
with the given RSU is overdue, is more than three
minutes.  It is normal for communications to be overdue
for up to three minutes, but not longer. If
communication with a particular RSU is overdue for
more than three minutes, but the base station radio
is present and functional, and communication with
other RSUs is normal, a communication problem is
indicated with respect to the RSU in question.

NOTE:  Communications may report several minutes overdue if changes
have been made to the sleep settings of an RSU.  Once communications
have been made, the “Comm Due” window should function properly.

Figure 5-10.
Comm Overdue

Figure 5-9.  RSU Properties Window

Figure 5-8.  RSU Sleeping
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A communication failure with a given RSU
may also be detected in the “ExtensBase
Diagnostics” window or log file.
If communication with a given RSU has
been interrupted, an “RSU n: Status = No
Comm” line will appear in the “ExtensMon
Diagnostics” window.  Contact technical
support for information regarding accessing
the ExtensBase Diagnostics window.

Complete the following troubleshooting steps to verify communications with
a single RSU.

• If the ExtensMon “Voltage vs. Time” display (Ch. 4, Sec.4-5.3.6)
shows a steadily decreasing value over several days, the sleep settings
may need to be lengthened, or the battery or voltage regulator in the
RSU enclosure may be non-functional. Contact the technical support
team for further information regarding battery and voltage regulator
testing and replacement.

• Consult the documentation provided with the RSU in question to
determine its “Radio ID” number. The number entered on the “RSU
Properties – RSU Properties” window must be identical to the number
provided for the given RSU (Ch. 3, Sec. 3-4.1.1).

• Inspect the RSU solar panel and solar panel cable leading to the RSU for
damage. If either the solar panel or solar panel power cable are missing
or damaged, order new components from the technical support team.
Follow the instructions given by the technical support team and the
SlideMinder hardware manual for proper installation of these
components.

• Inspect the RSU antenna and the antenna cable leading to the RSU
for damage. If either the antenna or antenna cable are missing or
damaged, order new components as appropriate from the technical
support team. Follow the instructions given by the technical support
team and the SlideMinder hardware manual for proper installation
of these components.

• Open the RSU enclosure and inspect the power and antenna cables
for proper connection to the appropriate terminals within the enclosure
(consult the SlideMinder hardware manual for details). If the cables
appear to be improperly connected, please consult the technical
support team before proceeding.

Figure 5-11. Diag. - RSU Status
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• Check the LEDs on the front of the black box labeled “VLM-2000”
inside the RSU enclosure. At least one of these LEDs should be
illuminated to indicate that power is available and the system is running.

If all of these steps have been followed and the RSU (extensometer) remains
non-functional, the RSU may have to be replaced. Please contact the technical
support team for further guidance.

5-1.4 No RSU Communication
If no communication is taking place with any of the RSUs, all units in the
main ExtensBase window will display a red “Comm Overdue” warning. If
this is the case, verify that the base station radio is functional. (Sec. 5-1.1)

If the base station radio is present and functional, yet no communication is
taking place with any of the RSUs, contact the technical support team for
further guidance.

5-1.5 ExtensMon Not Found
Valid communication between ExtensBase and the ExtensMon server is
necessary before any RSU (extensometer) data can be stored in the central
database or viewed on the ExtensMon display. A failure in communication
between ExtensBase and the ExtensMon server will generally be noticed
first at the ExtensMon server. (Sec. 5-2.1)

A communication failure
between ExtensBase and the
ExtensMon server will be
indicated in the “ExtensBase
Diagnostics” window (Ch. 3,
Sec.3-3.4). If communication
has failed between the two
programs, the “ExtensMon”
box in the lower left-hand
corner of ExtensBase
Diagnostics window will
turn from green to red.

Figure 5-12.  Comm Failure
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If communication has been interrupted between ExtensBase and the
ExtensMon server, follow these steps to troubleshoot the ExtensBase end of
the communications link. (See Section 5-2.1, below, for instructions regarding
the ExtensMon server end of the communications link.)

• Verify that the ExtensMon server is running. Communication cannot
take place between the two programs if one or the other is not running.

• Verify that a database has been opened in the ExtensMon server
program. The ExtensMon server will not attempt to communicate
with ExtensBase if a database is not open. If there is no database
open, the ExtensMon program window will be blank.

• Check the IP addresses and port numbers listed in the ExtensBase
“RSU Properties – System Properties” window. See Section 3-2.3 for
further details regarding proper ExtensBase communications setup.

• Use the “Ping” command to verify that the network connection
between ExtensBase and ExtensMon is functional. To use the “Ping”
command, first determine the IP address of the ExtensMon server,
then click the Windows “Start” menu on the computer running
ExtensBase and select the “Run…” option. At the “Open” prompt,
type in “cmd.” When the cmd.exe window appears, type “ping”
followed by a space followed by the IP address of the ExtensMon
server. If the network connection is working, it will reply.  The output
should look similar to the following illustration (Fig. 5-13).

Figure 5-13.  Replying to “Ping” Command
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If the network connection between ExtensBase and ExtensMon is
not functional, the “Ping” command will time out. The output will
look similar to the following illustration (Fig. 5-14).

If all of these steps have been followed and ExtensBase still cannot
communicate with the ExtensMon server, try the procedures outlined in the
following section (5-2.1). Contact the technical support team for further
guidance if this does not solve the problem.

5-2. EXTENSMON

The ExtensMon server program collects and displays data sent by the Remote
Station  Units (RSUs), also known as extensometers. The ExtensMon server
is also responsible for issuing warnings when ground movement exceeds
preset limits or extensometer parameters exceed preset limits. Consult the
following sections if problems are encountered with any of these features.

5-2.1 ExtensBase Not Found
Valid communication between
ExtensBase and the ExtensMon
server is necessary before any
RSU (extensometer) data can be
stored in the central database or
viewed on the ExtensMon display.
A failure in communication between
ExtensBase and the ExtensMon
server will be indicated by the words
“Not Connected” in the status bar
located at the bottom of the ExtensMon main window.

Figure 5-14.  Request Timed Out

Figure 5-15.  Not Connected
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If the status bar reads “Not
Connected,” attempt to connect to
ExtensBase by selecting “Connect to
ExtensBase” from the Acquire menu
(Ch. 4, Sec. 4-3.4). The status bar on
the ExtensMon server main window
will read “Connecting” while the
connection process takes place.

If the connection attempt is
successful, within a few seconds, the
status bar will display the word “Connected.” If the ExtensMon server status
bar returns to “Not Connected” after a few seconds, there is a problem with
the connection between the ExtensMon server and ExtensBase.

NOTE: A database must be opened in the ExtensMon server before any
communication can take place between the ExtensMon server and ExtensBase.

If a database is open in ExtensMon and there is still no connection between
ExtensMon and ExtensBase at the ExtensMon server, try the following
the steps. (See also Section 5-1.5 for instructions regarding the ExtensBase
end of the communications link.)

• Verify that the ExtensBase program is running. Communications
cannot take place between the two programs if one or the other is
not running.

• Check the IP addresses and port numbers listed
in the ExtensMon “Program Settings” window.
See Ch.4, Sec. 4-2.1.1 for further details
regarding ExtensMon communications setup.

• Use the “Ping” command, as described in
Section 5-1.5, to verify that the network
connection between ExtensBase and ExtensMon
is functional.

If all of these steps have been followed and the ExtensMon server still cannot
communicate with ExtensBase, try the procedures outlined in Section 5-1.5.
If this does not solve the problem, contact the technical support team for
further guidance.

Figure 5-17.
Program Settings

Figure 5-16.  Connecting
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5-2.2 Bad Vector Graph Display
When a database is first opened, the default display is the “Displacement
Vector” display (Section 4-5.3.3). The displacement vector (or velocity vector)
display will look incorrect if the latitude and longitude have not been entered
correctly for the extensometer (RSU) being displayed.

If a vector graph display is incorrect, select the “Modify Extensometer” option
from the Tools menu on the main ExtensMon window. Select the desired
extensometer from the “Name” drop-down box and enter the correct latitude

and longitude in the “Location:”
boxes. See Section 4-4.2 for further
details regarding extensometer
parameters.

Figure 5-19.  Modify (Update) Extensometer

Figure 5-18.  Bad Vector Graph
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5-2.3 Warnings Not Transmitted
The ExtensMon server may be configured to transmit various warning
messages depending on the data received from the extensometers (RSUs).
Warning messages may be transmitted based on ground movement and battery
or temperature limits (Ch. 4, Sec. 4-5). If the ExtensMon server is not
transmitting the warnings as specified, follow the procedures outlined below.

• Check for proper communication between ExtensBase and the
ExtensMon server. See Sections 5-1.5 and 5-2.1, for details
regarding communication problems between ExtensBase and the
ExtensMon server.

• The status bar at the lower edge of the main ExtensMon server window
must read “Connected” and “Monitoring Warnings.” If the status bar
reads “Not Connected,” see Section 5-2.1. If the status bar reads
“Connected” and “Not Monitoring Warnings,” click on the Warnings
menu in the ExtensMon main window. Click on “Monitor Warnings”
(Section 4-6.4). There will be a check mark next to “Monitor
Warnings” when incoming data is being monitored. Clicking on
“Monitor Warnings” toggles it on and off.

• Close the current database and bring up the “Program Settings”
window. Check the communication settings to ensure that the
warnings are directed as appropriate. No warnings will be issued if
these settings are not properly configured (Ch. 4, Sec.4-2.1).

• Be sure that the client computer designated to receive the warning
message is on and connected to the LAN.

• The file ExtensLog.txt, located in the ExtensMon directory is an error
log file, which may contain information useful for debugging problems.

If all of these steps have been followed and the ExtensMon server still
does not transmit warnings properly, contact the technical support team
for further guidance.




